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Technology Tutorial:  Loading TI Connect 
 

TI Connect is a linking software used to download and transfer data, and connect 
calculator, computer and internet platforms. 
 
Note: In order for TI Interactive 1.3 software to interface with the TI 
Connect software a 1.5 or higher version of TI Connect must be 
downloaded.  
 
Advance Preparation 

Google search: TI Connect, select TI Connectivity Kit (*) and Bookmark. 
Website: Appearance of the Texas Instruments website may differ. 
http://education.ti.com/us/product/accessory/connectivity/down/download.html 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
1. TI requires a registration/login process to the website. Registration/Login process 

follows: 
 
A. Google/Browse to website, if bookmarked use bookmark: 

http://education.ti.com/us/product/accessory/connectivity/down/download.html 
 

* 
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B. Select the appropriate computer platform (*). If a Security Alert window pops 
up click OK.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

* 

* 

or 
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C. The registration/login process will begin at this point. Select New User 
Registration or input User Name and Password. Personal information and an 
agreement with terms will follow for new users. As illustrated below (*). If a 
Security Alert window pops up click YES. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

* 

* 
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2. Select the TI Connect(tm) language platform that is appropriate. Then click on the 
file name (*). Example: Windows (English) version was selected. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Select Save (*), and save to the Desktop. Download will begin. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

* 
*

* 
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4. Once download is complete, close all windows. A TI Connect_eng.exe icon    
will appear on the desktop. 
 

5. Double click on the TI Connect_eng.exe icon   , and run set up. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6. The TI Connect Set-up will go through several windows including a software license 
agreement. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
(continue) 
 
 

* 

**
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7. Close all windows when setup is complete. 

 

8. A TI Connect icon    will appear on the desktop. 
 
9. Drag the TI Connect _eng.exe icon to the trash can, and delete. 

*

*

*

* 
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Technology Tutorial:  Loading TI Probability Simulator 
APPS 

The TI Probability Simulation APPS is an application software with interactive animation 
of the following probability situations: tossing coins, rolling dice, drawing marbles, 
spinning spinners, drawing cards, and generating random numbers. The TI Probability 
Simulator APPS requires the TI-73 Operating System 1.6. 
 
Advance Preparation 

• Check for TI Connect software on computer; if not loaded, load using Technology 
Tutorial Loading TI Connect. 

• If the computer has TI Interactive, make sure it is version 1.3 or higher. 
• Connect a TI-73 calculator to a computer with internet access using a TI Silver 

Graph Link. Be sure to turn on the calculator. 
• Google and Bookmark the website (appearance of the Texas Instruments website 

may differ): http://education.ti.com/us/product/apps/probsim.html 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. TI requires a registration/login process to the website. Registration/Login process 
follows: 
 
A. Google/Browse to website, if bookmarked use bookmark: 

http://education.ti.com/us/product/apps/probsim.html  
 

* 
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B. Select download for the appropriate calculator. For Example: TI-73 Explorer (*) 
was selected. If a Security Alert window pops up click OK.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 

* 
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C. The registration/login process will begin at this point. Select New User 
Registration (*) or input User Name and Password. Personal information and an 
agreement with terms will follow for new users, as illustrated below (*). If a 
Security Alert window pops up click YES.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
 

* 

* 
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2. You will need to download the TI-73 Explorer(tm) Operating System first, 
followed by the Probability Simulation (*). For Example: TI-73 Explorer(tm) 
Operating System was selected first. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Select the TI-73 Explorer(tm) Operating System, select Save (*), and save to the 
Desktop. Download will begin. 
 
 
 
 
 
 
 
 
 
 
 
 
 

2nd* 
1st*

*

*

*
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4. Once download is complete, minimize the window, My Pick-Up…. A TI Operating 

System icon    will appear on the desktop. 

5. Click and drag the TI Operating System icon    onto the  

TI Connect icon  . 
 

6. A OS Download Warning will appear, click OK. (Note: all applications on the 
calculator will be deleted when upgrading to the new operating system.) 
 
 
 
 
 
 
 
 
 

7. Transferring of the operating system to the TI-73 calculator will begin. While the 
operating system is transferring, the graphing calculator will read: Receiving 
Calculator Software. This process will take about 5 to 10 minutes. Once you have 
downloaded the operating system, the calculator will read: Validating Calculator 
Software followed by Graph Explorer Software 1.60 title screen. 
 
 
 
 
 
 
 
 
 
 
 
 

8. Maximize the window, My Pick-Up. Repeat steps 2-5 for downloading the 
Probability Simulation. If a Document and Setting window pops up click and OK, 
then restart download by selecting the Probability Simulation again.  
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9. Transferring of the Probability Simulation APPS will begin and the TI-73 calculator 
will read: Receiving Pro Sim APP. This process will take about 1 minute. 

 
 
 
 
 
 
 
 
 
 
 
 

10. Check to see if you have downloaded the Probability Simulation APPS correctly 
onto the calculator, by selecting the 9 key on the calculator. If the download was 
successful a new application titled Prob Sim will be in the list. 
 
 
 
 
 
 
 
 
 

11. Drag to trash the TI Operating System and the Probability Simulator icon to the 
trash can and delete. 
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Technology Tutorial:  TI-Interactive: The Big Question 
Presenter(s) Spreadsheet 

Create a Presenter(s) Spreadsheet before starting the activity. This will enable the 
presenter(s) to flow between each group’s data efficiently. 
 
Advance Preparation 

• Load TI-Interactive 1.3 software (will need to be purchased) onto computer: 
See TI-Interactive instructions manual. 

• Load TI-Connect 1.5 software onto computer: See Loading TI Connect 
Technology Tutorial. 

 
Create Presenter(s) Spreadsheet 

1. Open TI-Interactive  . 
 

2. In the toolbar select the Spreadsheet icon  . 
 
 
 
 
 
 
 
 
 

3. A spreadsheet will be activated in the form of a Data Editor. 
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4. Starting with cell A1 click and drag to the lower right-hand side of the spreadsheet 
until all cells are highlighted. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5. In the tool under the Format menu select Cells. 
 
 
 
 
 
 
 

6. Set Alignment to Center and Number Format to General, select Apply and then OK. 
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7. Click on cell B2 and type in Possible Outcomes, then Enter. Continue until you have 
set up all labels and groups. Some columns may need to be resized; instructions for 
resizing are below illustration. Note: if more than five groups are needed just include 
another column labeled accordingly. Also, if fewer than five groups participate in the 
activity, having extra columns set up will not affect the outcome of the calculations. It 
is better to have too many groups set up, than too few. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
To resize column width or roll height: move curser into the column labels (or roll 
labels) when the curser changes from a pointer to a two sided arrow (*) and a 
resizing line appears, click and drag to the desired size. 
 
 
 
 
 
 
 
 
 
 
 

 
 

*
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8. Click on cell C3, in the toolbar select Functions ( ( )f x ). 
 
 
 
 
 
 

9. Scroll down to SUM, and then click OK. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

10. Highlight cells E3 to I3. Note: There will be changes in the Sum formula as you 
highlight the cells. Enter a close ()) parentheses and then Enter. Also, the sum will be 
zero at this time. 
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11. Repeat steps 9-11 for cells C4, C5, C6, C7, and C8 using the corresponding Group 
cells. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

12. Click on cell B10, and input label, Total Trials. Click in cell B11 and use the sum 
formula to total the frequency column, this will require highlighting cells C3-C8. 
Enter a close ()) parentheses and then Enter 
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13. Table with formatted cells. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

14. Click on the C column. In the toolbar under the Insert menu select Cells. In the pop-
up menu select Shift cells right and click OK. 
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15. Resize new column as explained in step 7, and input label Experimental 
Probability. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
16. Click in cell C3. Enter  =  followed by clicking on cell D3, backslash and cell G14, 

and then Enter 
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17. Repeat step 16 for cells C4, C5, C6, C7, and C8 using the appropriate corresponding 
cells.  

 
Note: Due to division by zero an error message will appear until data has been entered. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
18. In the toolbar under the File menu select Save To Document. Save to the Desktop as 

The Big Question. 
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Technology Tutorial:  TI-Interactive - The Big Question 
Graph 

 
Create a Presenter(s) Spreadsheet before starting the activity. This will enable the 
presenter(s) to flow between each group’s data efficiently. 
 
Advance Preparation 

• Create The Big Question Presenter(s) Spreadsheet using the Technology 
Tutorial: The Big Question Present(s) Spreadsheet. 

 
Create Presenter(s) Graph 
1. Open TI-Interactive: Middle School-Explore Explain 3 Spreadsheet.tii or The Big 

Question spreadsheet (if formatted by presenter.) 
 

2. Double click on the graphic (*). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

* 
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3. Have one group at a time input their results for each outcome. Once two or three 
groups have inputted data, highlight the Possible Outcomes and Experimental 
Probability columns, by clicking on cell B3 and dragging to cell C8. 
(If using TI-83 calculators, data may be collected using a linking device between the 
computer and a calculator. Steps for linking and importing data can be found at the 
end of this tutorial.) 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. In the toolbar select the Graph icon  . Note: The graph icon may look different 
based on the last type of graph created. In the Graph menu select the Y= graph icon  

. 
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5. Notice the sample shows data plotted, and corresponding cell ranges set under Stat 
Plots in the Functions window. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6. Reset point size by clicking on the Point Selection Box, and selecting 3 in the Size 
drop-down menu. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

*
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7. Reset point color by selecting Black in the Color drop-down menu. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

*
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8. Click Format (*), under Window set the x- and y-axis minimums and maximums as 
shown, click Apply, and then OK. 
 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

* 

*
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9. Under Y= in the Function window input the appropriate function. The leader notes 
for this activity discuss function.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
10. Reset the line width by clicking on the Line Selection Box, and selecting the second 

width choice in the Weight drop-down menu. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

* 
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11. Reset line color by selecting Black in the Color drop-down menu. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
12. Have another group input their data, continue process as classroom discussion 

continues 
 

13. Close Middle School-Explore Explain 3 Spreadsheet.tii  or The Big Question 

using the close box  . 
 

 
 
 
 
 
 
 

*
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Importing Data using a Linking Device 
One at a time each group of participants will connect their calculator to the computer 
using a TI-Graph Link USB. Make sure the calculator in turned on, and at home screen. 
 
*Note: Graphic of tables may differ, but procedure is the same. 
 
1. Open TI-Interactive: Middle School-Explore Explain 3 Spreadsheet.tii or The Big 

Question spreadsheet (if formatted by presenter.). 
 

2. Double click on the graphic (*). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Select the List tab at bottom of spreadsheet. 
 
 
 

 
 

 
 
 
 

* 

*
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4. Select the Import TI Device Data icon on the Toolbar. 
 
 
 
 
 

 
Follow instruction and select the list that contains the data you intend to import. 
(Instructions will vary here depending on what type of calculator the participants use.) 
 
5. Data will import into the appropriate list: In the example, data were in L1 of the 

calculator; therefore they were imported into L1 in the list editor.  
 
 
 
 
 
 
 
 
 
 
 

6. Highlight data as shown above and select Copy in the Edit menu. 
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7. Select the Spreadsheet tab. 
 
 
 
 
 
 
 
 
 
 

8. Highlight the first cell under the appropriate Group, and select Paste under the Edit 
menu. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

9. Data will be imported into the appropriate cells. 
 

 
 
 
 
 
 
 

*
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Technology Tutorial:  Trials, Trials, Trials Activity 
 

The following is an example: participants may create a table and labels independent of 
this example. Therefore participants table and graph will vary. 
 
Creating the Table 

1. Open an Excel    document. 
 

2. The following illustration is the product created in steps 3-7. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Click on cell A1 and drag to cell D10. 
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4. In the toolbar under the Format menu, select Cells. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5. Under the Alignment tab, use the pop-down menu under the Horizontal and Vertical 
text alignment to select Center. Select Wrap Text by clicking in the box under text 
control. Click OK. 
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6. Click cell B4 and enter Different Outcomes, and click on cell C4 and enter 
Frequency. If needed, adjust the size of the cells by clicking on the line to the left of 
the column and dragging the line left or right as needed. (Short cut: Use the down 
arrows on your keyboard to move down the column.) 
 
 
 
 
 
 
 
 
 
 
 

7. Click on cell B5 and enter 1, continue entering 2-6 in the cells below as illustrated. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

8. Table is complete and ready to input data from the Group Activity Sheet: 
Simulation #1 frequency table. Input data using cells C5-C10. (Example uses the 
data found in the leader notes.) 
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Creating the Graph 
Participants may select the type of graphical representation of their choice; therefore, two 
possible types of graphs appear: Bar Graph, and Pie Graph. You may want to 
experiment with others. 
More than one graph may be created and displayed side by side. 
 
Bar Graph 
 
1. Click and drag curser over the data to highlight. The example has cells C5-C10 

highlighted. 
 
 
 
 
 
 
 
 
 
 
 

2. Select the Chart Wizard    in the toolbar. 
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3. Step 1: Select the Column chart type, then click Next.  
Step 2: Since the data was highlighted first click Next. 
Step 3: Input a Chart tile (Trials, Trials, Trials), Categories (X) axis (Possible 
Outcomes), and Categories (Y) axis (Frequency), then click Next. 
Step 4: Select As object in, and then Finish. 
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4. A graph will appear on the spreadsheet. 
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Pie Graph 
1. Complete steps 1 and 2 of the Bar Graph on page 4. 
 
2. Step 1: Select the Pie chart type, and then click Next.  

Step 2: Since the data was highlighted first click Next. 
Step 3: Input a Chart tile (Trials, Trials, Trials), then select the Data Labels tab and 
check Category name, Percentage and click Next. 
Step 4: Select As object in, and then Finish. 
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3. A graph will appear on the spreadsheet. 
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Technology Tutorial:  TI-73: Trials, Trials, & More Trials 
Activity with APPS 

 
Notice there are two different sets of Simulation Cards. The best scenario is to use 
Simulation Card Set 2 With APPS Program. Card set 2 with APPS Program requires 
the Probability Simulator APPS, you can perform the activity without the simulator 
using Card Set 2 without APPS Program.  
The following is an example: participants will generate different data independent of this 
example. Therefore participant’s data and list will vary. 
 
Advanced Preparation 

Check all calculators for the Probability Simulator APPS by checking the  9  
list for Pro Sim. 
 
 
 
 
 
 
 
 
 
If the applications list does not contain the Probability Simulator APPS, then refer 
to the Technology Tutorial Loading TI Probability Simulator APPS and load the 
application software. 
 
 

Trials, Trials, & More Trials with Probability Simulator 
1. Press  ^. 

 
2. Press  9. 

 
3. Select the Probability Simulator, Prob Sim. Press  b  twice. 
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4. Follow the instructions below for each specific simulation. 
 

 
Number Cube 

A. Select Roll Dice. Press  b. 
 
 
 
 
 
 
 
 
 

B. Press  '  which will activate the first roll of the die. Continue pressing  
'  until you have recorded 10 rolls. 
 
 
 
 
 
 
 
 
 

 
Spinner 

A. Select Roll Dice. Press  b. 
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B. Press  (  to activate settings. Using the arrow keys: set Sections to 6 and 
Graph to Freq. Press  *. 
 
 
 
 
 
 
 
 
 
C. Press  '  which will activate the first spin. Continue pressing  '  
until you have recorded 10 spins. 
 
 
 
 
 
 
 
 
 

5. To quit Probability Simulation: Press &. 
 
 
 
 
 
 
 
 
 
6. Press  &. 
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7. Press  *. 
 
 
 
 
 
 
 
 
 

8. Press  &. 
 
 
 
 
 
 
 
 
 
 
 
 

Creating a Line Plot 
1. Press  ^. 

 
2. Press  3. 

 
 
 
 
 
 
 
 
 

3. Input the possible outcomes into L1 (list 1), one at a time. Press  b  each time. 
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4. Curser over to L2 (list 2) using the arrow key  ". Input the frequency of each 
possible outcome one at a time. Press  b  each time. 
Record frequencies in the Groups Activity Sheet: Simulation #2 table. 
In this example: 2, 6, 1, 7, 4, 0 will be the frequencies of the six possible outcomes  
 
 
 
 
 
 
 
 
 

5. Press  -&. 
 
 
 
 
 
 
 
 
 

6. Select Stat Line. Press  b. 
 
 
 
 
 
 
 
 
 

7. Using the curser keys and b, select Plot 1 On, Type Line Plot, Xlist L1, and 
Ylist L2. 
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8. Press  '. Set window using illustration. 
 
 
 
 
 
 
 
 
 

 
 
9. Press  *. 

 
 
 
 
 
 
 
 
 

10. To quit: Press  -.. 
 

11. Press  -^. 
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Technology Tutorial:  TI-73: Trials, Trials, & More Trials 
Activity with No APPS 

 
Notice there are two different sets of Simulation Cards. The best scenario is to use 
Simulation Card Set 2 With APPS Program. Card set 2 with APPS Program requires 
the Probability Simulator APPS, the activity can be done without the simulator using 
Card Set 2 without APPS Program.  
The following is an example: participants will generate different data independent of this 
example. Therefore participant’s data and list will vary. 
 
Trials, Trials, & More Trials with No Probability Simulator 
1. Press  ^. 

 
2. Press  1. 

 
 
 
 
 
 
 
 

3. Curser over to the 1  PRB menu using the " key. 
 
 
 
 
 
 
 
 
 

4. Follow the instruction below for each type of simulation. 
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Number Cube 
A. Select dice(. Press  b. 

 
 
 
 
 
 
 
 

B. To simulate 5 rolls of a die: Enter  RE. 
 
 
 
 
 
 
 
 
 

C. Press  b, which will generate the first 5 rolls. 
 
 
 
 
 
 
 
 
 

D. Press  b, to generate the next 5 rolls. 
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Number Generator  
A. Select randInt(. Press  b. 

 
 
 
 
 
 
 
 
 
 

B. To generate 5 random integers between 1 and 6: Enter  Y¡S¡RE.  
 
 
 
 
 
 
 
 
 

C. Press  b which will generate the first five numbers. 
 
 
 
 
 
 
 
 
 

D. Press  b which will generate the next five numbers. 
 
 
 
 
 
 
 
 
 

5. To quit: Press  -^. 
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Creating a Line Plot 
1. Press  ^. 

 
2. Press  3. 

 
 

 
 

 
 
 
 

3. Input the possible outcomes into L1 (list 1), one at a time. Press  b  each time. 
 
 
 
 
 
 
 
 
 

4. Curser over to L2 (list 2) using the arrow key  ". Input the frequency of each 
possible outcome one at a time. Press  b  each time. 
Record frequencies in the Groups Activity Sheet: Simulation #2 table. 
In this example: 2, 6, 1, 7, 4, 0 will be the frequencies of the six possible outcomes  
 
 
 
 
 
 
 
 
 

5. Press  -&. 
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6. Select Stat Plot 1. Press  b. 
 
 
 
 

 
 

 
 
 

7. Using the curser keys and b, select Plot 1 On, Type Line Plot, Xlist L1, and 
Ylist L2. 
 
 
 
 
 
 
 
 
 

8. Press  '. Set window using illustration. 
 
 
 
 
 
 
 
 

 
9. Press  *. 

 
 
 
 
 
 
 
 
 

10. To quit: Press  -.. 
 

11. Press  -^. 


